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NEW QUESTION 1
- (Topic 3)
When a flow runs an action, it generates a runtime value, which stays the same for the duration of the flow. What is the name of this runtime value?

A. Trigger runtime value

B. Sequence runtime value
C. Starting runtime value
D. Data pill runtime value
E. Input runtime value

Answer: D
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/data-population.html

NEW QUESTION 2
- (Topic 3)

< — Catalog Task

Save
Add to Visual Task Board
Metrics Timeline

As: Configure >

Export )
Cond View >
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Copy URL

Copy sys_id
Show XML
dd History )

Reload form

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table

B. The Form Context menu > Configure > Table

C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 3
- (Topic 3)
What attributes can you manage, using System Properties > Basic Configuration UI16? (Choose five.)

A. Browser tab title

B. Module text color

C. Preferred browser

D. Base theme

E. Font style

F. Animation style

G. Header background color
H. Banner Image

Answer: ABDGH

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/task/t_ConfigureLogoColorsSysDfltsUI16.html

NEW QUESTION 4
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- (Topic 3)
What are the three key tables in an enterprise CMDO? Choose 3 angwers

. sn_cmdt_bak
. Sh_emdb_ci
. Cmap_ret_ci
. cmdb_bak
.cmdb_ci

. sh_eomdb

. cmap

GTMMmMmoOm>

Answer: CEG

NEW QUESTION 5

- (Topic 3)

While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose
2 answers

A. Right click on Priority and select Configure Dictionary

B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label

D. Right click on Priority and select Configure Column

Answer: AC

NEW QUESTION 6
- (Topic 3)
When a custom table is created, which access control rules are automatically created? Choose 4 answers

A. delete
B. create
C. execute
D. read

E. update
F. write

Answer: ABDF

NEW QUESTION 7
- (Topic 3)
On the Form header, which icon do you use to access form templates?

A. Paperclip

B. Pages

C. Stamp

D. More Options {...)

Answer: D

NEW QUESTION 8
- (Topic 3)
Which type of scripts nun in the browser?

A. Script include Scripts

B. Business Rule Scripts

C. Access Contra! Scripts

D. Ul Policies and Client Scripts

Answer: D

NEW QUESTION 9
- (Topic 3)
Which field (or fields) is used as a unique key during imports?

A. Match Fields

B. Coalesce Fields
C. Key Fields

D. Sys IDs

Answer: B
Explanation:

Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 10
- (Topic 3)
Which tool graphically displays an infrastructure view for a configuration item (CI) and its relationship with other Cls?
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A. Schema Map

B. Dependency View
C. Dependency Map
D. Database View

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/business-service-management-map-
ng/concept/c_BusinesssServiceManagementMaps.html

NEW QUESTION 10

- (Topic 3)

The customer has asked that your change the default layout of the task list.
* Number

* Task Type

* Parent

* Short Description

* Assignment Group

* Assignment

* Updated

After navigation to the list, where would you click, to meet this requirement?

A. Right click on any column header, Context menu > Configure > List Layout
B. Right click List Gear icon > Configure > Columns

C. Click List Context Menu >Personalize List

D. Click List Context Menu > Configure Columns

Answer: B

NEW QUESTION 15
- (Topic 3)
What section on a task record would you use to see the most recent update made to a record?

A. Timeline
B. Journal
C. Audit Log
D. Activity

Answer: D

NEW QUESTION 17
- (Topic 3)
When using the Data Pill Picker, use which keys to dot-walk (6 fields in other tables?

A. Arrows

B. Plus, Minus

C. Ctrl ¢, Ctrl

D. Ctrl <, Ctrl >

E. Shift F4, Shit FS

Answer: A

NEW QUESTION 20
- (Topic 3)
On what part of the ServiceNow instance, would you find the option to access applications, like Incident Management?

A. Self Service Module

B. Application Navigator

C. Service Desk Homepage
D. Favorites

Answer: B

NEW QUESTION 22

- (Topic 3)

Here is an example of the criteria set for a knowledge base:

* Companies: ACME North America

* Department: HR

* Groups: ACME Manager

* Match All: Yes

In this example, what users would have access to this knowledge base?

A. Members of the ACME manager group, who are also members of HR Department and part of the ACME North America
B. Employees of ACME North America, who are members of HR Department or the ACME Manager group

C. Users which are members of either ACME North America, or HR Department, or ACME Manager Group

D. Member of the ACME Manager group, and HR department, regardless of geography
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Answer: A

NEW QUESTION 27
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to specify grouping and calculations to be run against me data?

A. Style

B. Format
C. Data

D. Configure
E. Group by

Answer: D

NEW QUESTION 30
- (Topic 3)
What are examples of Core tables in the ServiceNow platform?

A. Configuration, Connect, Chat
B. Team, Party, Awards

C. User, Task, Incident

D. Work, Caller, Timecard

Answer: C

Explanation:
Reference: https://www.basicoservicenowlearning.in/2019/12/create-table-in- servicenow.html

NEW QUESTION 31
- (Topic 3)
In what order are Access Controls evaluated?

A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
C. Table-level - most specific to most general; then Field-level « most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general

Answer: D

NEW QUESTION 33

- (Topic 3)

For your implementation, the following tables. are extended fram each ofher:

* Incident table is extended from Task table.

* Super Incident table is extended from Incident table,

In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table

B. Incident table i

C. a Parent table

D. Incident table is a Child table

E. Super Incident table is a Child table
F. Super Incident table is a Parent table
G. Super Incident table is a Base table
H. Task table is a Base table

I. Task table is a Parent table

J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 38
- (Topic 3)
What actions art taken to filter a long list of records to show only those which have “email” Short Description?

A. Click List Magnifier to expand column searc

B. on Short Description type %emai

C. click enter

D. Click List Magnifier to expand column search, on Short Description, type email, click enter
E. On Search bo

F. select text, type email, click enter

G. Click List Magnifier to expand column search, on Short Description type ‘email, dick enter

Answer: D
NEW QUESTION 40
- (Topic 3)

The ServiceNow platform supports a wide variety of plus-and-play application. You can
choose from the included workflow or build your own workflow. Which of following these workflows are included in the platform?
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A. Employee Workflows

B. Infrastructure Workflows
C. Federal Workflows

D. Manufacturing Workflows
E. Customer Workflows

F. IT Workflows

Answer: AEF

NEW QUESTION 45
- (Topic 3)
What framework can be used to manage the tables and Cis associated with a use case?

A. Common Service Date Model (CSDM) product view
B. Scename Dashboard

C. CMDB Use Case Modelar

D. Cl Use Case Modeler

Answer: A

NEW QUESTION 49
- (Topic 3)
Which feature ensures data consistency white importing data using import sets and web services?

A. Client Script
B. Ul Policy

C. Data Policy
D. CSDM

E. Business Rule

Answer: C

Explanation:

Data policies are used to define rules that govern the creation, modification, and deletion of data in ServiceNow. These policies can be used to ensure data
consistency by enforcing data quality standards and preventing invalid or inaccurate data from being imported.

References:

? ServiceNow Product Documentation: Data policies overview - https://docs.servicenow.com/bundle/vancouver-platform-
administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 50
- (Topic 3)
Which framework can automatically populate values for the priority and Category field based on the Short description field value?

A. Ul Policy

B. Assignment Rule

C. Action

D. Predictive intelligence
E. CSDM

Answer: A

NEW QUESTION 53
- (Topic 3)
What section on the notes tab, shows the history of the work documented on the record?

A. Journal
B. Activity
C. Diary

D. Audit Log
E. Timeline

Answer: B

NEW QUESTION 58

- (Topic 3)

You have been asked to create a way for users to order a new iPhone, but only if they get two levels of approval. The approvers and users should be automatically
notified at each approval level. What feature would you use to manage the approvals and notifications?

A. Parent-Child Approvers.
B. Approval Chains

C. Flows

D. Approval Criteria

E. Approver Delegates

Answer: D

NEW QUESTION 59
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- (Topic 3)
When you set a policy that is applied to all data entered into the platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Client
B. Server
C. Browser
D. Network

Answer: B

NEW QUESTION 61
- (Topic 3)
Tables may have a One to Many relationships. From the Service Catalog, what are examples of tables having a one to many relationships? (Choose three.)

A. One Approval can have many Requests

B. One Request can have many Requested ltems

C. One Requested Item can have many Approvals

D. One Requested Item can have many Catalog Tasks
E. One Cart can have many Requests

Answer: BDE

NEW QUESTION 62
- (Topic 3)
Your customer requires that they be able to monitor which users are performing impersonations in their instance. What would you do to meet that requirement?

A. Add the role Log Write [sn_log_write] to the Impersonator Group
B. Create user update set for impersonation tracking

C. Activate the glide.sys.log_impersonation prop

D. From User icon, select Elevate Roles

E. On the Impersonator role record, right click and select Create Log

Answer: C

Explanation:
Reference https://support.servicenow.com/kb?id=kb_article view&sysparm_article=KB0717055

NEW QUESTION 66
- (Topic 3)
Which action enables personalization in a form for the admin role, only?

A. Navigate to sys_form_properties.list and set the property glide.ui.enable_personalize_form.admin to true.

B. Navigate to Context Menu > Configure > Form Layout and select 'Enable Personalization' and Enter the '‘admin’ role.
C. Navigate to Context Menu > Configure > Table and add the role '‘Admin’ in the 'Available User' list box.

D. Navigate to sys_properties.list find the property glide.ui.personalize_form.role and set the Value to admin.

Answer: D

Explanation:

This action allows only users with the admin role to personalize forms by using the Personalize Form buttonl. The other options are either invalid or do not restrict
personalization to the admin role only.

ReferencesPersonalize a formUI settings and personalizationPersonalization

NEW QUESTION 71
- (Topic 3)
An order for new office equipment has Men placed through the Service Catalog. How would you view the lists of requests after the orders have Men placed?

A. All > Service Catalog > Open Records > Items
B. In the Navigation Filter, type 'request

C. Let' and press the Enter key.

D. All > Tables and Columns > Taste

E. All > Service Catalog > Requests

Answer: A

NEW QUESTION 75

- (Topic 3)

A subject matter expert routinely receives tasks which have been worked by first level support, before receiving the assignment
What could you suggest. to make it easier for the expert to read only the work notes in the Activity log?

A. Click Context menu > Work Notes View

B. Click Personalize icon and select Activity Stream

C. Right click form header > Form Layout > Add Work Notes Section
D. Click Funnel icon and select only work notes

E. Click Context menu > History

Answer: D
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NEW QUESTION 76
- (Topic 3)
What action will allow you to personalize layouts of columns in a list?

A. Click Gear icon > Personalize window options > Select the appropriate columns

B. Select the column to be personalized > Click Edit icon (Penal) > Choose me options to personage
C. Context Menu > View > Personalize

D. Select the column to be personalized and right at the header > Choose the options to personalize

Answer: A

NEW QUESTION 79
- (Topic 3)
What are the three key tables in an enterprise CMDB? Choose 3 answers.

A. omadb_rel_ci
B. sn_emdb

C. sn_emdb_ci
D. Ey omdb

E. sn_emdb_bak
F. omdb_ci

G. emdb_bak

Answer: ADF

NEW QUESTION 81
- (Topic 3)
Which statement correctly describes the differences between a Client Script and a Business Rule?

A. A Client Script executes before a record is loaded and a Business Rule executes after a record is loaded
B. A Client Script executes on the server and a Business Rule executes on the client

C. A Client Script executes on the client and a Business Rule executes on the server

D. A Client Script executes before a record is loaded and a Business Rule executes after a record is updated

Answer: C

Explanation:

Reference: https://community.servicenow.com/community?id=community _question&sys_id=77a80361
db5cdbc01dcaf3231f9619d9#:~:text=The%20major%20difference%20between%200f,delet
ed%2Fqueried%20from%20data%?20base.&text=After%20that%2C%20the%20Client%20s cripts,Client%20scripts%20that%20work%20onSubmit

NEW QUESTION 85
- (Topic 3)
What feature do you use to specify which users are able to access a Service Catalog Item?

A. Can Read Role

B. Catalog User Role
C. Can Order Tab

D. User Criteria

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow- platform/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 86
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table

B. Ensures user can get to work as quickly as possible

C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355

NEW QUESTION 91

- (Topic 3)

Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer

B. Process Automation Designer
C. Process Workflow Designer
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D. Workflow Editor

Answer: B

NEW QUESTION 94
- (Topic 3)
What Service Catalog feature do you use to organize items into logical groups?

A. Variable sets
B. Catalog items
C. Sections

D. Categories

Answer: A

NEW QUESTION 99
- (Topic 3)
What access does a user need to be able to import articles to a knowledge base?

A. sn_knowledge_import

B. sn_knowledge contribute
C. Can contribute

D. Can import

Answer: C

NEW QUESTION 100
- (Topic 3)
Which component of a table contains a piece of data for one record?

A. Factor

B. Field

C. Datapoint
D. Element
E. Item

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataDictionaryTables.html

NEW QUESTION 101

- (Topic 3)

The Employee On-boarding team has asked for a way for managers to order computers, monitors, business Cards, and cell phones for new employees. How
would you proceed to meet this requirement?

A. Create Record Producer
B. Create Order Guide

C. Create Requested Item

D. Create On-boarding Bot

Answer: B

NEW QUESTION 102
- (Topic 3)
To apply a Ul Policy to all views, which field should be set to true in its definition record?

A. Inherit

B. Reverse if false
C. On lowed

D. Global

Answer: A

NEW QUESTION 103

- (Topic 3)

Which set of steps is used to import spreadsheet data into a ServiceNow table?
A. Load Data, Create Transform Map, Run Transform

B. Select Import Set, Select Transform Map, Run Transform

C. Select Data Source, Schedule Transform

D. Define Data Source, Select Transform Map, Run Transform

Answer: A

Explanation:
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These are the steps to import spreadsheet data into a ServiceNow table, as explained in the official documentation1 and the video tutorial2. The other options are
either incomplete or incorrect.
Referencesl: Import a spreadsheet - Product Documentation: Utah - Now Support Portal2: How To Import Data Into ServiceNow - YouTube

NEW QUESTION 106

- (Topic 3)

You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.

B. Activate the application plug in, on your personal dev instance.

C. Search the wiki for the sales demo request form,

D. Activate the application plug in, on your company's production instance.

Answer: B

NEW QUESTION 109
- (Topic 3)
What are advantages of using spokes for integrations? Choose 3 answers

A. Reduces the need for code

B. Features scale and control mechanisms

C. Free spokes are available in the ServiceNow Store
D. Ensures discoverability and reuse

E. Automated event management

Answer: ADE

NEW QUESTION 114

- (Topic 3)
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the associated record?
- INCident
{ = INco010112 -f
Number INCDOL0112
> Caller survey user Q. o5 (0
Category Inquiry / Help b
Subcategory None "

A. Drilkdown
B. Lookup
C. Quickview
D. Preview
E. Snapshot

F. Reference:

Answer: F

NEW QUESTION 115

- (Topic 3)

If users would like to locate and assign a task to themselves in the Platform, What action could they perform from the list view to make the assignment?
Choose 2 answers

A. Select the record using the check box, then select the Person icon

B. Double click on the Assigned to value, type the name of the user, and select the green check

C. Select the record using the check box then select the Assign To Me Ul action on the List Header
D. Right click on the Task number and select the Assign to me option in the menu

E. Select the Task number, and select the Assign to me Ul action on the form

Answer: DE

NEW QUESTION 120

- (Topic 3)

The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response

Passing Certification Exams Made Easy visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 P QsseaQs LJ https://www.2passeasy.com/dumps/CSA/ (412 New Questions)

B. Save + Update
C. Write + Read
D. Submit + Query
E. Insert + Verify

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 125
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
C. Client
D. Browser

Answer: B

Explanation:

A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.

ReferencesData policies

NEW QUESTION 129
- (Topic 3)
What component of the ServiceNow infrastructure defines every table and field in the system?

A. Data Atlas

B. Table Class Manager
C. Schema

D. Dictionary

E. Field Map

Answer: D

NEW QUESTION 134
- (Topic 3)
What are the steps for importing data using an import set?

A. Select source file; Run automap; Transform data; Clean up target table

B. Set up LDAP; Test map: Create update set; Run import: Apply update set

C. Identify source; Import transform map: Run transformer; Verity import

D. Load the data; Create transform map; Transform data; Clean up import table

Answer: D

NEW QUESTION 139
- (Topic 3)
How is a user defined in ServiceNow?

A. user is a record stored in the User Preference [Sys_user_preference] table
B. A User is a record stored in the Profile [sys_user_profile] table

C. A user is 2 field in the LOAP integration

D. A user is a record stored in the User [sys_user] table

Answer: A

NEW QUESTION 140

- (Topic 3)

Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that applies to the entire Incident table (all rows and
fields)?

A. incident .*
B. incident.all
C. incident .!
D. incident.None

Answer: A
Explanation:
The object name for a rule that applies to the entire Incident table is incident

.* . which means any field on the incident table. The other options are not valid object names for access control rules.
ReferencesAccess control list rulesAccess Control List in ServiceNowAccess Controls
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NEW QUESTION 145
- (Topic 3)

After you create a new table, what is the best practice regarding the navigation pane? Choose 2 answers

A. Set the filter condition on the Application Menu

B. Set the font style on both the Application Menu and the Module
C. Specify which Roles are able ta see the Module

D. Specify which Roles are able to see the Application Menu

E. Create Application Menu with the same name as the table label
F. Create Module with the plural of the table label

Answer: CD

NEW QUESTION 150
- (Topic 3)
What is the most common role that has access to almost all platform features, functions, and data?

A. Security Admin [security_admin]
B. Sys Admin [sys_admin]

C. Admin [sn_admin]

D. System Administrator [admin]
E. Base Admin [base_admin]

Answer: C

Explanation:

Reference: https://developer.servicenow.com/dev.do#!/guides/quebec/now-platform/glossary/developer-glossary

NEW QUESTION 155

- (Topic 3)

Access controls are evaluated in this order:

* 1. Match object against table ACL

* 2, Match the object against field ACL

Within step 1 above, what order are the table ACLs evaluated?

A. Specific to general: Table.Field ACL, Parent Table.Field ACL, *.Field ACL
B. Bottom to top: Table AC

C. Table.Field ACL, Parent Tabl

D. Field ACL

E. General to specific: Table ACL, Table.Field ACL, Parent Table, Field ACL
F. Top to bottom: Wildcard Table ACL, Parent Table ACL, Table ACL

G. Specific general: Table ACL, Parent Table ACL, Wildcard (*) ACL

Answer: E

NEW QUESTION 159
- (Topic 3)
What type of query allows you to filter list data using normal words, instead of the condition builder?

A. Natural Language Query

B. Alexa Query

C. Machine Learning Query

D. Predictive Intelligence Query
E. Auto-suggest Query

Answer: A

NEW QUESTION 161
- (Topic 3)
Which data consistency settings can be achieved using Ul Policy? Choose 3 answers

A. Setting fields to accept the data with ‘n’ number of characters
B. Setting fields hidden

C. Setting fields to accept the data in an expected format

D. Settings fields read-only

E. Setting fields mandatory

Answer: BDE

NEW QUESTION 164
- (Topic 3)
What is used to determine user access to knowledge bases or a knowledge article?

A. sn_kb_read, sn_article_read
B. Privacy Settings

C. Read Access Flag

D. User Criteria
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Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/concept/user-access-knowledge.html

NEW QUESTION 167
- (Topic 3)
On the knowledge base record, which tab would you use to define which users are able to write articles to the knowledge base?

A. Can Read

B. Can Write

C. Can Contribute
D. Can Author

E. Cannot Author

Answer: C

NEW QUESTION 172
- (Topic 3)
Which tab on the knowledge base record, would you use to identify the sets of users who are able to read articles in that knowledge base?

A. Access List
B. Can Access
C. Accessible to
D. Can Read

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/task/t_SelectUserCriteria.html

NEW QUESTION 176
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon

B. Additional Actions or Context Menu
C. Hamburger icon

D. Cake icon

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 178
- (Topic 3)
What is the definition of a group?

A. An escalation pod

B. A department

C. A collection of users

D. A collection of subject matter experts
E. A team of users

Answer: C

NEW QUESTION 179
- (Topic 2)
When creating a global custom table named “abc”, what is the table name that is automatically assigned by the platform?

A. snc_abc
B. abc
C.u_abc
D. sys_abc

Answer: C

NEW QUESTION 184
- (Topic 2)
What are three security modules often used by the System Administrator? (Choose three.)

A. System Properties > Security
B. Utilities > Migrate Security

C. System Security > Security
D. Self-Service > My Access
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E. System Security > Access Control (ACL)
F. Password Management > Security Questions
G. System Security > High Security Settings

Answer: AEG

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/reference/r_GeneralSecuritySettings.html

NEW QUESTION 186
- (Topic 2)
What are the three components of a filter condition?

A. Fiel

B. Operator and Value

C. Conditio

D. Operator, and Value

E. Field, Condition, and Value
F. Variable, Field, and Value

Answer: A

NEW QUESTION 187
- (Topic 2)
On a Business Rule, the When setting determines at what point the rule executes. What are the options for specifying that timing?

A. Before, After, Async, Display

B. Prior to, Synchronous, on Update

C. Insert, Update, Delete, Query

D. Before, Synchronous, Scheduled Job, View

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/business-rules/reference/r_ HowBusinessRulesWork.html

NEW QUESTION 192
- (Topic 2)
What feature can track the amount of time that a task has been open, to ensure that tasks are completed within an allotted time?

A. Task Escalation Clock

B. Service Level Agreements
C. Inactivity Monitor

D. Response Time Clock

E. Business Time Remaining

Answer: B

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform- administration/page/administer/task-
table/reference/r_ToolsForDrivingTasks.html#:~:text=Service%20level%20agreements%20
can%?20track,completed%20within%20an%20allotted%20time.&text=Inactivity%20monitors
%20ensure%20that%20tasks,a%20predefined%20period%200f%20time

NEW QUESTION 195
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout

B. Context Menu > Configure > Form Layout

C. Context Menu > Configure > Form Design

D. Right click on header > Add > Field

E. Context Menu > Form > Designer

F. Right click on header > Configure > UX Dashboard

Answer: BD
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t_CreateCustomField.html

NEW QUESTION 199
- (Topic 2)
What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.

B. Performance Analytics can show trends; Reports cannot.
C. Reports can be run on a scheduled basis; Performance Analytics cannot.
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D. Performance Analytics data can be published to Dashboards; Reports cannot.
E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 203
- (Topic 2)
When you need to orchestrate business processes across services with little technical user knowledge, which utility would you use?

A. Flow Manager

B. Flow Designer

C. Flow Editor

D. Workflow Editor

E. Workflow Designer

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/orchestration/reference/r-orchestration-introduction.html

NEW QUESTION 207
- (Topic 2)
What is an Event in ServiceNow?

A. An Event is a trigger that has a direct response in the platform

B. An Event is an indication to the ServiceNow processes that something has occurred
C. An Event is an indicator that a Priority 1 (P1) Incident has been logged

D. An Event is a recognized, scheduled occurrence of a process

Answer: B

NEW QUESTION 208
- (Topic 2)
Which icon would you double click, to expand and collapse the list of all Applications and Modules?

Servicennw. senice Management

Self-Service

=]

A. Star

B. Clock

C. Application
D. Funnel

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/task/uil6-navigator-tasks.html

NEW QUESTION 212

- (Topic 2)

A new service catalog item is being developed, but should only be visible to managers inside the HR Department. What method would you use to fulfill this
requirement?

A. Specify the Dept_Mgr role on the catalog content block

B. Add the Department Manager group to the catalog item’s user criteria
C. Add the Department Manager group to the catalog item’s ACL

D. Only publish the item in the HR service catalog

E. Use a Dept_Mgr ACL on the HR service catalog

Answer: C

NEW QUESTION 214
- (Topic 2)
Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that is specific to the Incident table and the Major
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Incident field?

A. Incident.Major_Incident

B. incident=>major_incident
C. incident<=>major_incident
D. incident||major_incident
E. incident.major_incident

Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/contextual-security/concept/acl-rule-types.htmi

NEW QUESTION 217

- (Topic 2)

What are the three permission requirements that must evaluate to true for an access control rule to apply?
Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 218
- (Topic 2)
How do you make a list filter available to everyone?

A. Make active, set visibility, and save

B. Assign a name, set visibility, and save
C. Assign a group, set visibility, and save
D. Make active, assign a name, and save

Answer: B

NEW QUESTION 219

- (Topic 2)

While showing a customer their incident form, they ask to change the Priority values to display their internal terminology P1, P2, P3, P4. They want it to be
consistent across all Tasks. How would you do that?

Right click on Priority and select what?

A. Configure Lists

B. Show Options

C. Configure Task
D. Show Choices

E. Show Choice List
F. Configure Options

Answer: F

NEW QUESTION 221
- (Topic 2)
What field contains a record’s 32-character, unique identifier?

A.sn_rec_id
B. rec_id
C.u_id

D. sys_id
E.sn_gu_id
F.sn_sys id
G.id

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/table-administration/concept/c_UniqueRecordldentifier.html

NEW QUESTION 225
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table

C. A group defines a set of users that share the same location

D. A group defines a set of users that share the same job title

Passing Certification Exams Made Easy visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 P QsseaQs LJ https://www.2passeasy.com/dumps/CSA/ (412 New Questions)

Answer: B

NEW QUESTION 227
- (Topic 2)
What is a no-code approach to control the mandatory or read-only state of a form field?

A. Ul Action

B. Client Script
C. Ul Script

D. Ul Rule

E. Ul Policy

Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 230
- (Topic 2)
New records, new groups, and modified configuration Items (Cls): what do they have in common?

A. They are included in an Update Set

B. They are not captured in an Update Set
C. They are customizations

D. They do not have anything in common

Answer: A

NEW QUESTION 234
- (Topic 2)
After finishing your work on High Security Settings, what do you do to return to normal admin security levels?

A. Select Normal role

B. Log out and back in

C. Use System Administration > Normal Security module
D. Select Global Update Set

E. End Impersonation

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/concept/c_HighSecuritySettings.html

NEW QUESTION 236
- (Topic 2)
What Is the purpose of the Fitter navigator In the Application Navigator?

A. Filter applications in order of use

B. Quickly navigate to applications and modules
C. Collapse and expand applications

D. List applications In order of Top Requests

Answer: C

NEW QUESTION 237
- (Topic 2)
Which plugin allows users to install multiple applications, application-customizations. or plugins at once?

A. Application Integration and Plugin Delivery (A1PD) SpokeBatch Install

B. Continuous Integration and Continuous Delivery (CICD) SpokeBatch Install
C. Multiple Integration and Process Delivery (MIPD) SpokeBatch Install

D. Quick Integration and Multiple Delivery (QIMD) SpokeBatch Install

Answer: B

NEW QUESTION 238

- (Topic 2)

What is specified in an Access Control rule?

A. Groups, Conditional Expressions and Workflows

B. Table Schema, CRUD, and User Authentication

C. Object and Operation being secured; Permissions required to access the object

D. security_admin

Answer: C
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Explanation:
Reference: https://www.servicenowelite.com/blog/2019/10/2/access-controls#:~:text=An%?20instance%20uses%20access%20control,object%20and%20operati
on%20being%20secured

NEW QUESTION 240
- (Topic 2)
What do you call any component that needs to be managed in order to deliver services?

A. CSDM ltems

B. CMDB

C. Configuration item
D. Service Offerings
E. Asset

Answer: C

Explanation:
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION 243
- (Topic 2)
Group records are stored in which table?

A. Group [sn_user_group]
B. Group [sys_user_group]
C. Group [s_sys_group]

D. Group [u_sys_group]

Answer: B

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0832548

NEW QUESTION 244
- (Topic 2)
Which one of the following is an accurate list of changes that are captured in an Update Set?

A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields

C. Changes made to: tables, form

D. Business Rules, and data records

E. Changes made to: table

F. forms groups, and configuration items (Cls)

Answer: A

NEW QUESTION 246
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator

B. Match Criteria
C. Value

D. Column

E. Field

Answer: ACE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 251
- (Topic 2)
What ServiceNow tables can Administrators define as "destinations"” for imported data, when using Transform Maps in the System Import Sets application?

A. The Task table is the only table that can be a destination for imported data in the Transform Map module

B. The Inciden

C. Proble

D. Change, Task, and Service Catalog tables are the only tablesthat can be a destination for imported data m the Transform Map module
E. Only the Incident Problem, and Change tables can be a destination for imported data in the Transform Map module

F. Any ServiceNow table can be a destination for imported data in the Transform Map module

Answer: B

NEW QUESTION 252
- (Topic 2)

Passing Certification Exams Made Easy visit - https://lwww.2PassEasy.com



Welcome to download the Newest 2passeasy CSA dumps

@ 2 P QsseaQs LJ https://www.2passeasy.com/dumps/CSA/ (412 New Questions)

Where in Flow Designer can users access information about actions that are added to the flow?

A. Virtual Agent Help
B. Local Action Help
C. Help Panel

D. Flow Assistant

Answer: C

NEW QUESTION 253

- (Topic 2)

Your customer would like to create a new template to notify users who are affected by network outages at their site. Which module would you use to create a new
notification?

A. System Notification > Email > Notifications
B. Administration > Notification Overview

C. System Properties > Email > Settings

D. User Preferences > Email > Notifications
E. Click Gear > Naotifications > New

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/notification/task/t CreateANoatification.html

NEW QUESTION 257
- (Topic 2)
What icon do you use to change the label on a Favorite?

A. Clock

B. Hamburger
C. Pencil

D. Three dots
E. Triangle.

F. Star

Answer: C

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0781451

NEW QUESTION 260
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke

B. Activate trigger security rules

C. Activate application spoke, and plug-ins as needed

D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 261
- (Topic 2)
What needs to be specified, when creating a Business Rule? (Choose four.)

A. Ul action

B. Table

C. Fields to update

D. Who can run

E. Script to run

F. Application scope
G. Update set

H. Timing

I. Condition to evaluate

Answer: ABEF
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/task/t_EditingAUIAction.html

NEW QUESTION 262

- (Topic 2)

Which certificate-based authentication methods can be enabled so that users can log into the Service Portal? (Select all that apply) Select 2 Answers from the
below options

A. Extended Validation Access (EVA)
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B. Organization Verification Card (OVC)
C. Common Access Card (CAC)

D. Domain Authentication Card (DAC)
E. Personal Identify Verification (PI1V)

Answer: CE

NEW QUESTION 264
- (Topic 2)
What is a sys_id?

A. Unique 32-character identifier that is assigned to every record
B. A client-side Business Rule

C. A server-side Business Rule

D. Unique 64-character identifier that is assigned to every record

Answer: A

NEW QUESTION 267
- (Topic 2)
What is a Notification?

A. A new Knowledge article created by a Business Rule

B. A tool for alerting users that events that concern them have occurred
C. A message through Connect related to a Change Request

D. An email file attachment

Answer: B
NEW QUESTION 272

- (Topic 2)
What is the difference between a Ul Policy and Data Policy?

A. Data Policies run when data is entered through the form, by an Import Set, or by webservices, while Ul Policies are set only by web services

B. Data Policies can be converted into Ul Policies, but Ul Policies cannot be converted into Data Policies
C. Data Policies run regardless of how data is entered into ServiceNow, while Ul Policies are used for form interactions

D. Data Policies run only after Ul Policies run successfully

Answer: C

NEW QUESTION 275
- (Topic 2)

Which of the following statements describes how data is organized in a table?

A. A column is a field in the database and a record is one user
B. A column is one field and a record is one row
C. A column is one field and a record is one column

D. A column contains data from one user and a record is one set of fields

Answer: A

NEW QUESTION 278
- (Topic 2)

Which section of the ServiceNow Ul allows you to perform a global search?

A. Application Navigator
B. Banner frame

C. List pane

D. Content frame

Answer: B

NEW QUESTION 280
- (Topic 2)

Which fields can be configured in reporting to perform arithmetic, coalesce, concatenation, and length?

A. Sourcing fields

B. Function fields

C. Computational fields
D. Calculation fields

Answer: B

NEW QUESTION 285
- (Topic 2)
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A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this
issue?

A. Have them clear their cache.

B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.

D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 288
- (Topic 2)
In addition to the admin role, which one of the following roles allows a user to add or remove fields from a list?

A. personal ize.control
B. personal_list

C. ul_page_admin

D. ui_action_admin

Answer: A

NEW QUESTION 291
- (Topic 2)
Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot

C. Virtual Agent

D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 295
- (Topic 2)
How can administrators utilize the same content for different notification channels?

A. Configure Default notification content
B. Enable Actionable notification content
C. Provide Common notification content
D. Set up Related notification content

Answer: C

NEW QUESTION 298
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log

C. Access Control Rules

D. Application Scope

Answer: D

NEW QUESTION 301
- (Topic 2)
What is the purpose of a Data Policy?

A. Data Policies enforce security

B. Data Policies standardize data in Update Sets
C. Data Policies enforce data consistency

D. Data Policies apply to lists to standard data

Answer: C

NEW QUESTION 304

- (Topic 1)

What is a schema map?

A. A schema map enables administrators to define records from specific tables as trouble sources for Configuration Items

B. A schema map graphically organizes the visual task boards for the CMDB
C. A schema map graphically displays the Configuration Items that support a business service
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D. A schema map displays the details of tables and their relationships in a visual manner, allowing administrators to view and easily access different parts of the

database schema

Answer: D

NEW QUESTION 306
- (Topic 2)
What function do you use to add buttons, links, and context menu items on forms and lists?

A. Ul Policies
B. Ul Settings
C. Ul Actions
D. Ul Config

Answer: C

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/concept/c_UIlActions.html

NEW QUESTION 309
- (Topic 1)
What is the Import Set Table?

A. A table where data will be placed, post-transformation
B. A table that determines relationships

C. A staging area for imported records

D. A repository for Update Set information

Answer: C

NEW QUESTION 313
- (Topic 1)
A User is stored in which table?

A. User [sys_user]

B. User [ sys_user_group]
C. User [ syst_user_profile]
D. User [user_profile]

Answer: A

NEW QUESTION 318
- (Topic 1)
Which are states that you can make a field on a form using Ul Policy?

A. read-only
B. write-only
C. Necessary
D. Mandatory
E. Empty

F. Hidden

Answer: ADF

NEW QUESTION 323

- (Topic 1)

There are common types of Interfaces (Numeric Value) 6: There are six common types of interfaces

A. Homepage: Consists of navigational elements, functional controls, and platform information.

B. List: Display records from a data table, as well as allow you to edit the record information using the List Editor functionally.

C. Form: Data is entered into ServiceNow through forms

D. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets on a single screen.
E. Maps: Display ServiceNow data graphically on a Google map

F. Timelines: Used to track tasks or projects

Answer: C

NEW QUESTION 326
- (Topic 1)
Which of the following concepts are associated with the ServiceNow CMDB? (Choose four.)

A. Service Processes

B. User Permissions

C. Tables and Fields

D. A Database

E. The Dependency View
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Answer: ACDE

NEW QUESTION 331
- (Topic 1)
ServiceNow is a single-instance, multiple tenant architecture?

A. True
B. False

Answer: B

NEW QUESTION 333
- (Topic 1)
Which of the following statement describes the purpose of an Order Guide?

A. Order Guides restrict the number of items in an order to only one item per request

B. Order Guide provide a list of guidelines for Administrators on how to set up item variables
C. Order Guide provide the ability to order multiple, related items as one request

D. Order Guides take the user directly to the checkout without prompting for information

Answer: C

NEW QUESTION 335
- (Topic 1)
Which one of the following statements describes the purpose of a Service Catalog workflow?

A. A Service Catalog workflow generates three basic components: item variable types, tasks, and approvals

B. Although a Service Catalog workflow cannot send notifications, the workflow drives complex fulfillment processes

C. A Service Catalog workflow is used to drive complex fulfilment processes and sends notifications to defined users or groups
D. A Service Catalog workflow generates three basic components: item variable types, tasks, and notifications

Answer: C

NEW QUESTION 339
- (Topic 1)
What is a way that you can mark a knowledge article for review?

A. Flag article
B. Review
C. Bookmark
D. On Hold

Answer: A

NEW QUESTION 344
- (Topic 1)
What module in the Service Catalog application does an Administrator access to begin creating a new item?

A. Maintain Categories
B. Maintain Items

C. Content Iltems

D. Items

Answer: B

NEW QUESTION 346
- (Topic 1)
Which one of the following statements best describes the purpose of an Update Set?

A. An Update Set allows administrators to group a series of changes into a hamed set andthen move this set as a unit to other systems
B. By default, an Update Set includes customizations, Business Rules, and homepages

C. An Update Set is a group of customizations that is moved from Production to Development

D. By default, the changes included in an Update Set are visible only in the instance to which they are applied

Answer: A

NEW QUESTION 351
- (Topic 1)
What is generated from the Service Catalog once a user places an order for an item or service?

A. A change request
B. An Order Guide
C. Arequest

D. An SLA
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Answer: C

NEW QUESTION 355
- (Topic 1)
Configuration will not affect what others see on their forms.

A. True
B. False

Answer: B

NEW QUESTION 357
- (Topic 1)
A group is stored in which table?

A. Group[user group]

B. Group[sys_user]

C. Group[sys_user_group]

D. Group[sys_user_group_profile]

Answer: C

NEW QUESTION 360
- (Topic 1)
The display sequence is controlled in a Service Catalog Item using which of the following?

A. The Default Value field in the Catalog Item form
B. The Sequence field in the Catalog Item form

C. The Order field in the Variable form

D. The Choice field in the Variable form

Answer: C

NEW QUESTION 364
- (Topic 1)
Which term refers to application menus and modules which you may want to access quickly and often?

A. Breadcrumb
B. Favorite

C. Tag

D. Bookmark

Answer: B

NEW QUESTION 369
- (Topic 1)
Reports can be created from which different places in the platform? (Choose two.)

A. List column heading
B. Metrics module

C. Statistics module

D. View / Run module

Answer: AD

NEW QUESTION 372
- (Topic 1)
Which of the following is used to initiate a flow?

A. A Trigger
B. Core Action
C. A spoke

D. An Event

Answer: A

NEW QUESTION 373
- (Topic 1)
Which one of the following statements describes the contents of the Configuration Management Database (CMDB)?

A. The CMDB contains data about tangible and intangible business assets

B. The CMDB contains the Business Rules that direct the intangible, configurable assets used by a company
C. The CMDB archives all Service Management PaaS equipment metadata and usage statistics

D. The CMDB contains ITIL process data pertaining to configuration items
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Answer: A

NEW QUESTION 374
- (Topic 1)
Ul Policy can make fields read-only, mandatory, or hidden.

A. True
B. False

Answer: A

NEW QUESTION 375
- (Topic 1)
Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?

A. Form

B. List

C. Dashboard
D. Timeline

Answer: C

NEW QUESTION 379
- (Topic 1)
As it relates to ServiceNow reporting, which of the following statements describes what a metric can do?

A. A metric is a report gauge used on homepages to display real-time data

B. A metric is a time measurement used to report the effectiveness of workflows and SLAs

C. A metric is used to measure and evaluate the effectiveness of IT service management processes
D. A metric is a comparative measurement used to report the effectiveness of workflows and SLAs.

Answer: C

NEW QUESTION 383
- (Topic 1)
What is a formatter? Select one of the following.

A. A formatter allows you to configure applications on your instance

B. A formatter is a form element used to display information that is not a field in the record
C. A formatter allows you to populate fields automatically

D. A formatter is a set of conditions applied to a table to help find and work with data

Answer: B

NEW QUESTION 387
- (Topic 1)
Which technique is used to get information from a series of referenced fields from different tables?

A. Table-Walking
B. Sys_ID Pulling
C. Dot-Walking

D. Record-Hopping

Answer: C

NEW QUESTION 391
- (Topic 1)
Which application is used to change the number format per table?

A. Number Maintenance
B. System Maintenance
C. Table Maintenance

D. Record Maintenance

Answer: A

NEW QUESTION 396
- (Topic 1)
Table Access Control rules are processed in the following order:

A. any table name (wildcard), parent table name, table name
B. table name, parent table name, any table name (wildcard)
C. parent table name, table name, any table name (wildcard)
D. any table name (wildcard), table name, parent table name
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Answer: B

NEW QUESTION 397
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.

D. They provide options.

Answer: B

NEW QUESTION 402
- (Topic 1)
How are Workflows moved between instances?

A. Workflows are moved using Update Sets

B. Workflows are moved using Transform Maps

C. Workflows are moved using Application Sets

D. Workflows cannot be moved between instances

Answer: A

NEW QUESTION 404
- (Topic 1)
From the User menu, which actions can a user select? (Choose three.)

A. Send Notifications

B. Log Out ServiceNow

C. Elevate Roles

D. Impersonate Users

E. Order from Service Catalog
F. Approve Records

Answer: BCD

NEW QUESTION 407
- (Topic 1)
What defines conditions that are evaluated against users to determine which users can create, read, write, and retire knowledge articles.

A. User conditions
B. User info

C. User Criteria

D. User permissions

Answer: C

NEW QUESTION 411
- (Topic 1)
Which of the following allows a user to edit field values in a list without opening the form?

A. Data Editor

B. Edit Menu

C. List Editor

D. Form Designer

Answer: C

NEW QUESTION 414

- (Topic 1)

Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance

B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time

D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance
Answer: A

NEW QUESTION 416

- (Topic 1)

What is the master table that contains a record for each table in the database?

A. [sys_master_db]
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B. [sys_db_object]
C. [sys_master_object]
D. [sys_object_db]

Answer: B

NEW QUESTION 420
- (Topic 1)
Which three Variable Types can be added to a Service Catalog ltem?

A. True/False, Multiple Choice, and Ordered

B. True/False, Checkbox, and Number List

C. Number List, Single Line Text, and Reference
D. Multiple Choice, Select Box, and Checkbox

Answer: D

NEW QUESTION 423
- (Topic 1)
What is the function of user impersonation?

A. Testing and visibility

B. Activate verbose logging

C. View custom perspectives

D. Unlock Application master list

Answer: A

NEW QUESTION 427
- (Topic 1)
Which statement is true about business rules?

A. A business rule must run before a database action occurs

B. A business rule can be a piece of Javascript

C. A business rule must not run before a database action occurs
D. A business rule monitors fields on a form

Answer: B

NEW QUESTION 431
- (Topic 1)
Which one of the following statements describes a characteristic of role assignment?

A. Roles can contain other roles, when you are assigned a role, you inherit all the roles within that role
B. Users can click on the Personalize Role feature to try different roles

C. Arole is granted to a user by the System Administrator

D. Each user has a role in the ServiceNow platform

Answer: A

NEW QUESTION 432
- (Topic 1)
Ul Action can prompt that an Incident has been successfully submitted.

A. True
B. False

Answer: A

NEW QUESTION 433
- (Topic 1)
Access Control rules may be defined with which of the following permission requirements? (Choose three.)

A. Roles

B. Conditional Expressions
C. Assignment Rules

D. Scripts

E. User Criteria

F. Groups

Answer: ABD

NEW QUESTION 436
- (Topic 1)
Which type of tables may be extended by other tables, but do not extend another table?
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A. Base Tables

B. Core Tables

C. Extended Tables
D. Custom Tables

Answer: A
NEW QUESTION 441

FILL IN THE BLANK - (Topic 1)
FILL IN THE BLANK

is a computer program running as a service; a physical computer dedicated to running one or more services, or a system running a database.

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Server

NEW QUESTION 444
- (Topic 1)

Create Incident, Password Reset, and Report outage: what do these services in the Service Catalog have in common?

A. They direct the user to a record producer
B. They direct the user to a catalog property
C. They direct the user to a catalog Ul policy
D. They direct the user to a catalog client script

Answer: A

NEW QUESTION 445
- (Topic 1)
What is the platform name for the User table?

A. u_users
B. sys_users
C. x_users
D. sys_user

Answer: D

NEW QUESTION 447
- (Topic 1)
A Service Catalog may include which of the following components?

A. Order Guides, Exchange Rates, Calendars

B. Order Guides, Catalog Items, and Interceptors

C. Catalog Items, Asset Contracts, Task Surveys

D. Record Producers, Order Guides, and Catalog Items

Answer: D

NEW QUESTION 452
- (Topic 3)
On a form header, what icon would you click to access Template features?

A. Paper clip

B. More options (...)
C. Stamp

D. Context Menu

Answer: B

NEW QUESTION 455
- (Topic 3)

What process allows users to create, categorize, review approve and browse important information in a centralized location that is shared oy the entire

organization?

A. Self Service Management

B. Knowledge Management

C. Knowledge-Centered Management
D. Information Portal Management

E. Business Information Management

Answer: B
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Explanation:

Knowledge Management is the process that allows users to create, categorize, review, approve and browse important information in a centralized location that is
shared by the entire organizationl. Knowledge Management helps users to find relevant and accurate information quickly, reduce the need to rediscover
knowledge, and improve the quality of service and customer satisfactionl.

References
? Knowledge Management - ServiceNow1

NEW QUESTION 459
- (Topic 3)
What ServiceNow feature allows you to include data from a secondary related table on a report?

A. SQL

B. Dot Walking
C. Outer Join
D. Joins

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/concept/c_HowToAccessRelatedTables.html

NEW QUESTION 464
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category

B. On the Filter Menu, select Group By > Category

C. Click Group On icon, select Category

D. On Navigator Filter, type tablename.group.category and press enter

E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 465
- (Topic 3)
What actions are taken to filter a long list of records to show only those with the Category of Hardware?

A. On Breadcrumb, click the > icon, type Hardware and click enter

B. On the Category column header, right-click and select Show > Hardware

C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter

E. Click Funnel icon, type Hardware and click enter

Answer: C

NEW QUESTION 466
- (Topic 3)
What is the platform name for the Group table?

A. SyS_USer_group
B. Sys_group

C. group

D. sys_groups

Answer: A

NEW QUESTION 469

- (Topic 3)

What contains the configuration changes made in an instance (i.e. changes in a form) and
helps to implement the changes from the Dev environment to another environment?

A. Update sets

B. Transform maps

C. System dictionaries
D. Import sets

Answer: A

Explanation:

Update sets are the configuration changes made in an instance, such as changes in a form, that can be exported from one instance and imported into another.
This helps to implement the changes from the Dev environment to another environment, such as Test or Prod. Update sets capture the changes made to system
properties, Ul actions, business rules, workflows, and other customizations.

Referencesl: Get started with update sets - ServiceNow - Now Support2: Product Documentation | ServiceNow3: Update Set in ServiceNow, Captured, Non-
Captured, Commit, Import ...4: In depth Concepts Update Set in ServiceNow - Basico ServiceNow Learning5: Retrieving and committing update sets between
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different ... - ServiceNow

NEW QUESTION 471
- (Topic 3)

Which is the most efficient way to move large amounts of data between instances?

A. Export to Data Package
B. Export to XML

C. Update Sets

D. Export to Zip

Answer: B

NEW QUESTION 472

- (Topic 3)

What are examples of Ul Actions relating to forms?
Choose 3 answers

A. Form Context Menu
B. Form View

C. Form Buttons

D. Form Links.

E. Form Columns

Answer: ACD

NEW QUESTION 476
- (Topic 3)

While on an Incident record, how would you add a Tag for "Special Handling" to the record?

A. Click on the More options (.,.) icon, click Add Tag, type Special Handling, press enter

B. On the Special Handling field, check the box

C. On the Tag field, select Special Handling from the choice list
D. Click on the Context menu, select Add Tag, type Special Handling, press enter

Answer: A

NEW QUESTION 479
- (Topic 3)

What does Natural Language Query allow you to do on a list?

A. Automatically select a filter, based on keywords
B. Filter list by typing in a phrase

C. Predict the filter desired by the user

D. Speak to the condition builder

E. Set list filter, using audible commands

Answer: A

NEW QUESTION 482
- (Topic 3)

You have an existing customer, who is using workflows for their catalog items. Their existing purchasing policy is to require approval for any request that totals

over 31000. However, management wants to change the approval threshold to 31500. Which

workflow would you update to make this change?

A. Services Approval Processing

B. 6 Services Catalog Item Request
C. Service Catalog Request

D. Purchasing Process Flow

Answer: C

NEW QUESTION 485
- (Topic 3)

What are examples of Ul Actions, relating to Lists? Choose 4 answers

A. List Links

B. List Control

C. List Buttons

D. List Context Menu
E. List Override

F. List Choices

Answer: ACDF

NEW QUESTION 490
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- (Topic 3)
What are the three key tables in an enterprise CMDB? (Choose three.)

A. cmdb

B. sn_cmdb_bak
C.cmdb_rel_ci
D. sn_cmdb

E. cmdb_bak

F. cmdb_ci

G. sn_cmdb_ci

Answer: ACF

Explanation:
Reference: https://community.servicenow.com/community?id=community _question&sys_id=7ab22ad5 dbf20498d82ffb2439961938

NEW QUESTION 492
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification

B. The associated knowledge base

C. Under what conditions is the notification sent
D. Who receives the notification

E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 496

- (Topic 3)

When looking at a long list of records, you want to quickly filler, to show only those which have Shon Description containing email
How might you do that?

A. Click List Magnifier to expand column search, on Short Description, type “email, click enter
B. Click List Magnifier to expand column search, on Short Description, lype *email, click enter
C. Click List Magnifier to expand column search, on Short Description, type email, click enter
D. On Search box, select text, type email, click enter

Answer: A

NEW QUESTION 497
- (Topic 3)
Which tables are available by default in a ServiceNow instance? Choose 3 answers

A. User

B. Incident
C. Item

D. Issue
E. Project
F. Task

Answer: ABF

Explanation:

These tables are available by default in a ServiceNow instance because they are part of the core platform and are used to store essential data for users, incidents,
and tasks. The other tables are not available by default, but can be created or activated by installing plugins or applications.

Referencesl: Tables & Dictionary - Frequently asked Questions (FAQ) - ServiceNow?2: ServiceNow — The List of All Tables (sys_db_object)3: How To Set A
Default Field Value in ServiceNow? - The Snowball

NEW QUESTION 502
- (Topic 3)

servicenow w woritey  Mistory  Admin T —
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An order from the Service Catalog has been placed. Two records in the Platform are
created as a result. Which two records are associated with tins newly ordered item? Choose 2 answers
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A. A record of sc_task

B. A record of sc_req_llem table
C. A change record

D. An Incident record

E. A problem record

Answer: AB

NEW QUESTION 503
- (Topic 3)
What module enables an administrator to define destinations for imported data on any ServiceNow table?

A. Field Transform
B. Transform Map
C. Schema Map
D. Import Map

Answer: B

NEW QUESTION 505

- (Topic 3)

Roles can inherit permissions from other roles. Which role inherits all of the permissions of the catalog role and the user_critena_admm role plus has permissions
to create Items and Services?

A. item Admin [sn_item_admin]

B. Sys Admin [sys_admIn]

C. Catalog Admin [catalog_admin]
D. Catalog Auinor (sn_cataiog_write]

Answer: C

NEW QUESTION 508
- (Topic 3)
What module do you use to access the reports that are available to you?

A. Report > View /Run

B. Reports > Homepage

C. Self-Service>My Reports
D. Report > Overview

Answer: B

NEW QUESTION 512
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.

B. Use extremely large Import Sets, instead of multiple large Import Sets.

C. Create a new Import set table for each new data load.

D. Plan time before your import to remove obsolete or inaccurate data.

E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation:

This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.

Referencesimport and export resources page

NEW QUESTION 515
- (Topic 3)
As administrator, what must you do to access feature of High Security Settings?

A. Select Elevate Roles

B. Add security_admin role to your user account

C. Impersonate Security Admin

D. Use System Administrator < Elevate Roles module

Answer: A

NEW QUESTION 519
- (Topic 3)
One related list, which buttons are commonly used for managing the records on the list? Choose 3 answers

A. Publish

B. New
C. Ada
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D. Manage
E. Edit

Answer: BCE

NEW QUESTION 520
- (Topic 3)
Which application is used primarily to load data into ServiceNow?

A. Import Hub

B. System Import Sets

C. Data Import Configuration
D. Import Management

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/import-sets/reference/import-sets-landing-page.html

NEW QUESTION 522
- (Topic 3)
What types of entities can receive task assignments, in ServiceNow? Choose 2 answers

A. Groups

B. Users

C. Departments
D. Teams.

Answer: AB

NEW QUESTION 525
- (Topic 3)
What are the steps for applying an update set to an instance?

A. Retrieve, Preview, Commit
B. Specify, Transform, Apply
C. Retrieve, Assess, Apply
D. Get, Test, Push

E. Pull, Review, Push

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/hier-update-sets/concept/us-hier- overview.html#us-
hier-overview

NEW QUESTION 529
- (Topic 3)
How would you navigate to the Schema map for a table?

A. System Dictionary > Show Schema Map; Select Table

B. System Definition > Tables; Select Table; Go to Related links and click Show Schema Map

C. System Definition > Show Schema Map; Select Table

D. System Definition > Dictionary: Select Table; Go to Related links and click Show Schema Map

Answer: B

NEW QUESTION 530
- (Topic 3)
Security rules are defined to restrict the permission of users from viewing and interacting with data. What are these security rules called?

A. Role Assignment Rules
B. CRUD Rules

C. Scripted User Rules

D. Access Control Rules

E. User Authentication Rules

Answer: D

NEW QUESTION 531

- (Topic 3)

Which system property is added and set to true in order to see impersonation events in the System Log?
A. glide user_setting

B. glide sys all_jmpersonation
C. glide sys log_jmpersonabon
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D. glide.impersonation_setting
E. glide sys admin_login

Answer: C

Explanation:

The system property glide.sys.log_impersonation is added and set to true in order to see impersonation events in the System Log2. This property enables logging
of

impersonation events in the Event [sysevent] table, which can be accessed by navigating to System Logs > Events2.

References

? How to find the history of impersonations - Support and Troubleshooting - ServiceNow

NEW QUESTION 536
- (Topic 3)
What resource can you use to view details of the tables and configuration items (Cls) associated with a particular use case?

A. Scenario Dashboard

B. Cl Use Case Modeler

C. CMDB Use Case Modeler

D. Common Service Data Model (CSDM) product view

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html

NEW QUESTION 537
- (Topic 3)
On a filter condition, which component is always a choice list?

A. Operator

B. Filter Criteria
C. Operation

D. Match Criteria

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-elements/concept/c_ConditionBuilder.html

NEW QUESTION 538
- (Topic 3)
On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute

B. Label

C. Field

D. Column

E. Data Element

Answer: C

NEW QUESTION 541

- (Topic 3)

Which module would you use to customize your instances banner image, text and colors?
A Homepage Admin > Pages > Branding

A. System Ul > Ul Pages > Branding

B. System Properties > Branding

C. System Properties > Basic Configuration Ul16
D. Service Portal > Portals > Branding

Answer: D

NEW QUESTION 546
- (Topic 3)
What are benefits of assigning work tasks to a group, rather than to an individual? (Choose four.)

A. Group members can choose their tasks from My Groups Work
B. Groups can assign tasks to users based on on-call schedules
C. Site support members can pick tasks, based on Location

D. Groups can assign tasks to users based on skills

E. Group members can avoid tasks, which are nearing SLA breach
F. Groups can assign tasks to users based on availability

Answer: BCDF
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NEW QUESTION 551
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